8 Wellspring
B Software

ACH Processing: Implementation Steps 1 September 2015

Training Note

The ACH file created by PrintBoss is compiled from data stored in the ACH Definition section of the
Bank Account record, a Payee List, and the check/EFT batch being processed. Complex scripting
attached to the PrintBoss check form creates the file. A user will almost never need to edit the
script. Instead they will simply enter specific information which will be used in the ACH File
Header Record, the ACH Company/Batch Record and the PrintBoss Payee List. The rest of the
required information will come from the check/EFT batch as it is processed.

Implementation Steps

Complete the ACH Definition record from the appropriate Bank Account

Create a Payee List

Establish the method you want to use to match the Payee with the Payee entry on the list
Create the ACH copy type in the appropriate PrintBoss Form

The ACH file is created automatically during the print process

nepLwnE

Step 1: Complete the ACH Definition record

The following are steps for setting up the ACH Definition tab on the Bank Record.
Open the PrintBoss Master Application.

2. Click on the Edit menu and choose Bank List.

3. Select the bank for ACH and click the Edit Bank button.

4. Click on the ACH Definition tab. The following screen will display:

[y

PrintBoss Bank Edit

File Header Record Fields Company/Batch Record Fields || Balanced File

Immediate Destination Senvice Class Codes Routing NMum.
| [ 220- Credits Only -

Immediate Origin Company Name Account Num.

Immediate Destination Name Company Discretionary Data

Account Name

Immediate Origin Name Company |dentification

]}I— File ID Modifier (Increment for ~ Standard Entry Class
multi. files in a day) PRD - Prearraged Pmnt & Dep. = |

[¥] Prenote Override if checked Company Entry Description

@ More Info| Originating DFI Iden

Payee List [7] (active)
]Common |'.lj Edit I Create Empty Record in List 'I

jﬁ copy. | || glset Tags|| [} Paste | || Clear Tags [ o OK ] |a Cancel‘

5. Enter the appropriate data.
a. File Header Record Fields - These fields are referenced in the PrintBoss ACH File Editor
which is embedded in the PrintBoss check form on the SignOn tab.
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1. Immediate Destination - Enter the 9 character routing number of the bank that will
process the ACH file. This is the point that will receive the ACH file for processing. The
field name for PrintBoss is {bACHImdDstNo}.

2. Immediate Origin - Enter the 9 character routing number for this bank record.
Normally, this is the same value as the Immediate Destination unless the bank provides
other instructions. The field name for PrintBoss is {bACHIMmdOrgNo?}.

3. Immediate Destination Name - Enter the name of the bank for the Immediate
Destination. It may contain up to 23 characters. The field name for PrintBoss is
{bACHImdDstName}.

4. Immediate Origin Name - Enter the company name. It may contain up to 23
characters. The field name for PrintBoss is {bACHImdOrgName}.

5. File ID Modifier - This field starts with A and should be incremented for each file
printed in a single day. It will contain only 1 character. The field name for PrintBoss is
{bACHFileIDMode}

6. Pre-Note Override if checked - This field should only be checked the first time an
ACH is created for this bank record for the bank to test and should be removed after
testing. New recipients are pre-noted in the Payee List.

b. Company/Batch Record Fields - These fields are referenced in the PrintBoss ACH File

Editor which is embedded in the PrintBoss check form on the Header tab.

1. Service Class Codes - Select the appropriate 3 character Service Class Codes from
the drop down menu. The field name in PrintBoss is {bACHSvcClassCode}. The choices
are:

200 - Mixed

220 - Credits Only
225 - Debits Only
280 - Automated

2. Company Name - Enter the Company Name as it appears on this bank account. It
may contain 16 characters. The field name for PrintBoss is {bACHCompName}.

3. Company Discretionary Data - Enter one or more codes to identify this batch. It
may contain up to 20 characters. This is for company use only and is optional. The
field name for PrintBoss is {bACHCompDisc}.

4. Company Identification - Enter a specific company identifier, usually “1” followed by
the Employer Identification Number (EIN). It may contain up to 10 characters. The
field name for PrintBoss is {bACHComplID?}.

5. Standard Entry Class - Select the appropriate 3 character code from the drop down
menu. The field name is {bACHStdEntryClsCod}. The choices are:

CCD - Corporate to corporate EFT
PPD - Prearranged payment and deposit (consumer)

6. Company Entry Description - Enter a description for this batch that will be
communicated to the receiver, such as PAYROLL or PURCHASES. The designation is
established by the company. It may contain up to 10 characters. The field name for
PrintBoss is {bACHCompEntry} characters.

7. Originating DFI Identification - Enter the 8 character routing number with leading
zeros. The field name in PrintBoss is {bACHOrgDFIID}.

c. Balanced File - Select this column when the bank requires a balancing entry for the
credits (or debits) sent and listed in the Detail section of the ACH file. The following fields
will then appear on the Balance Record tab of the ACH File Editor.

1. Routing Number - Enter the routing number with leading zeros as entered in the
Originating DFI Identification field. It contains up to 8 characters. The field name for
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PrintBoss is {bACHBalRout}. A check digit is added by PrintBoss per the ACH Rules to
create a 9 character field.

2. Account Number - Enter the account number for this bank record. It contains 17
characters. The field name for PrintBoss is {bACHBalAcct}.

3. Account Name - Enter the company name as it appears on this bank account. It
contains up to 22 characters. The field name for PrintBoss is {bACHBalName3}.

d. Payee List - The Payee List provides the option of using a Payee List to provide the
required ACH information used on the Details tab of the ACH File Editor. Alternatively,
these fields may be assigned from data that is printed from the accounting system.

1. (active) - Select the Payee List check box to activate this feature.

2. Browse button - Select the folder "Browse” button to select the name of a Payee List.
The Payee List is created under the Edit menu. Create a Payee List for this bank
records before activating this option.

3. Add Record - Click on the “add record” drop down menu to choose how to treat new
records when there is no current match for the payee name. The choices are:

a. Create Empty Record in List — Creates an empty record with only the {DocRecip}
name from the check batch. The record will not be active in the Payee List.

b. Ignore Payee

c. Alert with option to Add/Ignore

e. More Info - Click this button to view a list of fields that must be assigned from data
printed from the accounting software or entered in the Payee List and well as optional fields
to assign.

6. Click OK on the PrintBoss Bank Edit window to save changes to the ACH Definition tab.

Step 2a: Create a Payee List — Importing a .CSV File

The data used to create the payee Detail records for the PrintBoss ACH file comes from one of two
places: the PrintBoss Payee List or by capturing fields on the check report and assigning that data
to specific elements required to be part of the ACH file. This section covers setting up the Payee
List by importing a .csv file.

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and choose Payee Lists.
3. Click Create to start a new Payee List.

a. Enter a File Name for the list. There are no requirements for the File Name.

b. Click OK to create the list entry.
Select the list you created and click the Editor button. The Payee List Browse window opens.
Entries can be made one at a time in the list by clicking on the + sign, or imported from a .csv
file. This section covers exporting a template to a .csv file and importing back into the Payee
List when completed. The first step is to create 1 record in the list to export the column
headings.

vk
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a. CI|ck the plus sign (4) to create the first record. The Payee List Edit window opens.
- Payee List Edit | 7

Payee Information

v Active Payment Type: |ACH

Payes (in accounting system)
1C0mmercial Electronic Systems, Inc

Payee ID {in accounting system)
]Cummerical Electronic Systems.

Payee Email Address
]accuunting@cestelecu.cum

Payee Email Address #2

J

Payee Misc:

J

Account 1 | Account 2 F\CCUIJI'IH]

() Rimanderoreiack | ae
" Percent —
' SetAmount _

Account Type
{7 Savings

I— 06 e s TR |

v oK | a Cancel

b. Select Active in the top right corner.
c. Enter the first Payee as it was entered in the accounting software.
d. Click OK to save this record.

6. Right click on the gears in the top left corner of the Payee List Browse grid and choose
Export. PrintBoss will indicate 1 record is selected.

7. Click Yes.
8. Enter a name and location to save this file. PrintBoss will save it as a Comma Delimited
(*.csv) file.

9. Navigate to the save location and open the *.csv file.
10. Enter values in the following fields. Many of these fields are associated with the Detail tab of
the ACH File Editor:
a. Payee - Enter the payee name as it appears in the accounting software. PrintBoss
uses this field to match the payee name on the check.
b. Payee ID - Enter an ID for this payee. Alternatively, the Payee ID can be used by
PrintBoss to match an ID on the check advice. DocPayeeID must be assigned in the
PrintBoss form to match on the Payee ID field. When both Payee ID and Payee are
used, PrintBoss will use Payee ID first and only use Payee when not match is found for
Payee ID. This field is optional. This field is available beginning with Version 5.71.6.
c. Active - Enter Y to activate this record. N denotes an inactive record.
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Email - Enter a Payee Email Address for this payee if you will be using the E-mail
feature in PrintBoss to E-mail Direct Deposit or EFT notifications.
Email2 - A second email field is provided if a second recipient is necessary.
Payment Type (PYMNTTYPE} - The Payment Type is a numeric value based on the
type of file selected. The values are:
i. 0 - N/A This type is never used for ACH, but may be selected when the
Payee List is only used to store email addresses for emailing documents
through PrintBoss.
ii. 1 - ACH Always select this type for ACH files.
iii. 2 -PS16 Only select this type when instructed by a Wellspring Software
technician.
Payee Misc (MISC) - The Payee Misc field is provided for any additional information
for PrintBoss to retrieve and include in a file or email.
Mode1l - Enter the Mode for Account 1 to determine the amount of the ACH transfer.

The most common choice is 1, Remainder of Check, to pay the entire amount of the

check. This choice requires no additional Amount/Percent entries. The choices are:
i. Inactive - Enter O (zero).
ii. Remainder of Check - Enter 1.
iii. Percent - Enter 2.
iv. Set Amount - Enter 3.
Amntl - Enter a fixed Amount or Percent for Account 1 for this payee. Leave blank
if Remainder of check is selected for the Mode. The field name is {ACHAmount} and
contains 10 characters, 8 dollar places and 2 cents places.
BnkID1 - Enter the routing number for Account 1 for this payee. This matches the
Bank ID field on the Payee List. The field name is {ACHRecvBankID} and contains 9
characters, 8 for the routing number and a check digit added by PrintBoss in
accordance with ACH Rules.
BnkActl - Enter the account number for Account 1 for this payee. This matches the
Bank Account Num. field on the Payee List. The field name is {ACHRecvBankAcct}
and contains 17 characters.
Namel - Enter the Individual/Company Name for this payee as it appears on
Account 1. The field name is {ACHRecvName} and contains 22 characters.

. ID1 - Enter the Individual/Company ID for this payee if there are two or more

identical names. The field name is {ACHRecvID}, contains 15 characters, and is
optional.
Prenote (PRE1) - Only select PreNote (Y) if this account is added after the PreNote
file has passed the bank.
Print Check (PREPRNT1) - This option is only available when Prenote is selected. A
value of T (True) is entered to print a check when for this Prenote. Otherwise, the
value is F (False).
TransCodel - Enter a code to identify if the Account Type. The field name is
{ACHTransCode} and contains 2 characters. The values are:

i 22 = Checking

ii. 32 = Savings
Discl - Enter an optional 2-digit code for this account that is meaningful only to the
originator. The field name is {ACHRecvDisc}, contains 2 characters, and is optional.

11. Only enter Account 2 or Account 3 if the amount of the check is to be divided between more
than one bank account.

12. Save changes to this file and click Yes to keep the features.

13.Return to PrintBoss, click on the Edit menu, and select Payee Lists.
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14. Select the appropriate Payee List and click Editor.

15. Click on the gears E in the top left corner of the Payee List Browse grid and select Import.
16. Select the appropriate .csv file and click Open. The list will populate with the .csv entries.

r

17.Select a record and click the up arrowhead to make changes to the selected file.
18. Click the Done button when you are finished.

Step 2b: Capture Payee Information from Accounting Software

The data used to create the payee Detail records for the PrintBoss ACH file comes from one of two
places: the PrintBoss Payee List or by capturing fields on the check report and assigning that data
to specific elements required to be part of the ACH file. This section covers capturing fields on the
check report and assigning that data to specific elements required to be part of the ACH file.

The following 3 fields must be assigned in the form using data captured from the accounting
software on each page:

1. Receiving DFI Identification + Check Digit (bank routing number) ACHRecvBankID
2. DFI Account Number (bank account number) ACHRecvBankAcct
3. Receiving Company Name or Individual Name ACHRecvName

The following 6 fields may optionally be assigned in the form using data captured from the host on
each page. If these fields are not assigned in the form, then they must be included on a
corresponding Payee List.

1. Identification Number or Individual Identification Number ACHrecvID

2. Actual amount deposited in account ACHAmount

3. Discretionary Data ACHRecvDisc
4. Effective Entry Date (in the form YYMMDD) ACHEfctvDate
5. Transaction Code ACHTransCode
6. Pre-Note Y/N (if yes, the will be incremented at processing) ACHPreNote

For more information about capturing data and assigning variables in PrintBoss please see the
PrintBoss Training Note, “"Capturing and Assigning Text” document number Q1029.

At this time, PrintBoss will not create an ACH File without a Payee List. Therefore, even if the
payee details are captured and assigned from the accounting software, a Payee List must be
create and maintained. Only three fields are required in order for the Payee List to work when the
remaining fields are assigned in the PrintBoss form. These fields are:

1. Active - This option must be selected to use this record.

2. Payee - Enter the value PrintBoss will use to find an exact match from the check/EFT batch.
The value can be either alpha and/or numeric characters. For example, the vendor ID can be
assigned as the Payee and used to match the value in this field. The corresponding PrintBoss
variable is {DocRecip}

3. Mode - Set to Remainder of Check for Account 1
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The other fields are optional and may be assigned or added to the Payee List, though they are not
required.

Two fields that might need to be set in the Payee List are:
1. Account Type - This is the ACHTransCode

2. Pre-Note - This is ACHPreNote

Step 3: Establish Matching Method for Payee

With the inception of the PrintBoss Payee List, it has been used for different functions within
PrintBoss. They include maintaining a list of E-mail addresses of employees for EFT payments;
maintaining a list of employees and vendors that receive ACH payment and for maintaining a list
of credit card payment vendors with PS16 files.

We have found that the 'Match on Payee ID' is most common for ACH users, while 'Match on
Payee' is most common for PS16 users. Some users need to match on both the Payee and Payee
ID fields.

A new feature was added to PrintBoss 5.73.1 under Options/Configuration/Internal tab called
'Search Payee List using this method:'

The drop down menu allows the following choices:
 Standard Mode (both Payee and Payee ID match)
+ Match on Payee

 Match on Payee ID

—— B = =
% PrintBoss Conﬁgurations Dialogl =
Settings |Lnternaf |Menus] Legacy]

Misc Local Properties:
Suppress warning that PrintBoss is the Windows Default Printer I Save Printer Settings

Suppress dialogs when appropriate: [ PrintDialeg [~ Archive [~ E-Mail [~ FaxSenice

Local Drive Letter for Signature Disks ] A =non-existent= _:J
TextCaptHst Last Used Count 15_ Print Status Screen Position | Screen Center '1
J [~ Minimize PrintBoss on startup

’ I'v1i'sc;'\b'pl'iﬁéfi'dn -F'r'o'pérti'es:
‘When launched by Acct. Host, Terminate PrintBoss After Batch Print [
Windows Print.Jab Limit 10 PrintJobs till Prompt to continue |0

; ]“_ Print Jobs received within these r_
Delay Between Print Jobs 1 0
: secs are treated as one batch.

Stop Before Print Job starts when invalid printer exists [
Default printer choice for new users (or Terminal Server Clients) is "use Win Default” [~ CocRecip
Force form pre-read for each page. (helps for multiple forms per batch) [ Length

o

: .ElankAppIicaﬁon F'roperﬁes:

Method of matching of Bank Code ]Enforce Exact Bank Code Match ;j Change

Allow for Selection when multiple Bank Codes match [ Auto Populate Banklist 1_5_ EEll_nkC?hde '
; 2 en

Allow bapk accounts fo be AP and Pavroll | with Unused Records ' =

Search Payee List using this method: | Standard Mode -

Match on F'ayee
Match on Payee ID
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Step 4: Create the ACH copy type in the appropriate PrintBoss Form

In addition to the Bank and Payee Lists, the PrintBoss Form needs to be setup to print the ACH
file. First, we will add a copy to the PrintBoss form to create the ACH file.

8.

1. Open the PrintBoss Master Application.
2.
3. Select the appropriate PrintBoss form and click the Editor button. The Editing Form window

Click on the Edit menu and choose Form Files.

opens.

. Select the Settings tab.
. Increase the number of copies by 1. For example, if the current Copies value is one, type 2 in

the field.

. Select the Multi-Parts & Printers tab.
. Click on the Printer & Tray Selections Saved In... drop down menu and select <Form> to save

these changes for all users.

T ™%

B2l Editing Form : "QB_CHKA" L= O], g8

RunTime Objects | Eooter Objects I Proprietary Objects | Misc |
Settings | Special Controls | Block Mirrors  Multi-Parts & Printers |F‘DF| Comments I

?'g'Cupies | Print Time iDestinatiﬂn Printer/Device” ESnurce Tray” |Cupy Name
| Original Elmmediate i<Default PrintBoss Printar> . Default

PC&W T Elmmediaté 5<F’nsiti§é Pa'y -F.iie-b- fﬁSéﬁl?iéEé.ﬂ-k.S-p-E(-: ;PosF'ay File
E[Cowz Immediate | <Positive Pay File> [ZJACH Sample ACH File
pCopyj [Immediate  <EMail> | Default ‘Email Copy
\Copy4 |Immediate (<PDFFile> | Defat  PDFAdice
|Copy5 |mmediate  <Positve PayFils>  [1PS00016  PS16Fle
lcoys Mo <OoaPnmspmen Dot Mospotewisd ||
l' Copy 7 |Mever i<Default PrintBoss Printer> . Default Virtual Card Request File
—Printer & Tray Selections Saved In._- i
]<F0rm> Settings Effect All Users ;}
o ] ) | <Default PrnntBoss Printer= : Bullzip POF Printer
*"Destination Printer/Device” and "Source Tray”
¥ |are stored/retrieved from form. so they ars ‘ |}

lcomman to all

’W oK x Cancel

S x

Locate the new copy, click on the Destination Printer/Device drop down menu and select
<Positive Pay File>. This feature supports ACH files in addition to Positive Pay files.
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9. Click on the Source Tray drop down menu and choose ACH Sample. This is the NACHA file that
comes with PrintBoss.
a. Click on the Source Tray drop down menu for the ACH copy and choose ACH Sample.
b. Click on the page symbol to the left of the Source Tray to open the Positive Pay / ACH File
Editor. The following is an image of the Master tab:

| Positive Pay / ACH File Editor : ACH Sample . A =
MEISTQF| SignOn | Header I Details | Balance Record | Footer | Sign0ﬁ|
Destination File Properties
File Name: (@]  c\ACHFile1 ach - B
Y Confirm Path / Filename at runtime
Mew File Name Generation: File Type: l
Start of Batch - ACH -]
Append Overwrite Method:
| Prompt for Over\Write, Append, Cancel v|
/| Exclude records with zero amount ¥ Auto add CR/LF to each script
Import / Export Positive Pay Settings Comments
| Import | Hormally, the SignOn/Header/Details/Footer/3ign0Off scripts -
p should never be modifed. These scripts use Variables that r |
| Export | are assigned in the PrintBoss Bank record, and some
p variables that are assigned in each captured check
and/or pulled from the PrintBoss' "Payee List™.
Allow FTP Upload -
Upload when complete 4 :
[ W o ] |x Cancel

1. File Name - Set the destination path and file name for the ACH file in the File Name
field. The browse button at the end of this field can be used to navigate to a location
and will save the path when a file name is entered.

2. Confirm Path / Filename at runtime - Select this option to verify the destination
location or file name before PrintBoss saves the ACH file.

3. New File Name Generation - The default is to generate a new file at Start of Batch.
This is the recommended setting.

4. File Type - The file type should be set to ACH.

5. Append Overwrite Method - The default is Overwrite existing File. The choices are:

i. Overwrite existing File
ii. Append to existing File
iii. Prompt for Overwrite, Append, Cancel

6. Exclude records with zero amount - This option is typically not used with ACH files.

7. Auto add CR/LF to each script - This feature adds a carriage return to the end of
each script and should ALWAYS be checked for ACH.

8. Import - Click this button to import the ACH Sample to embed in the PrintBoss form.

9. Export - This feature is used to save a file created as embedded in form. It is usually
not used with ACH.

10. Allow FTP Upload - Only select this option when FTP has been setup for ACH. This
feature is only available when Security is enabled. See Chapter 22, FTP, for more
information

11. Upload when complete - Select this option to automatically upload the FTP file once
it is created by PrintBoss. Only select his option after FTP has been setup. This feature
is only available when Security is enabled. See Chapter 22, FTP, for more information
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12. Comments - Provides comments associated with the ACH file.
c. Click the Import button and select ACH Sample to embed this file into the current form.

Note: The ACH Sample can be embedded into more than one PrintBoss Form and each embedded
file can utilize a different file path and name.

There are 7 tabs associated with the ACH File. The first 5 have been described previously in this
document. The last two are as follows:

1. Footer - The Footer tab contains fields for the “8"” record(s) and apply specifically to a batch.

Positive Pay / ACH File Editer: <Embedded in form=> =]
Master} SignOn} Header I Details] Balance Record Footer ]SignOﬁ]
1 ||n[:H Company/Batch Control Record (footer)

2 Fld Pos Len Hame.. Description

3 g | 1 81, 1: Record Type Code

4 "{Pad:«{bACHSvcClassCode}»,3,T}" | 2 82, 3: Service Class Code.. 2208=Credits;225=Debit

5 "{FormatHum:'{BatchCount}',6,8,'8",""' Hide}" | 3 85, 6: Entry Count

6 "{ACHBatchHash}" | & 11, 18: Entry Hash

7 "{FormatHum:'8.88',10,2,'0",'08" Hide}" | 521, 12: Total Debit Entry Dollar Amount

& "{FormatHum:'{BatchAmnt}',18,2,'8","8' ,Hide}" | 6 33, 12: Total Credit Entry Dollar Amount

92 "{Pad:«{bACHCompID}=», 18, T}" | 7 45, 18: Company Identification

1@ “{pPad:'", 19, T}" | 8 55, 19: (0)Hessage Authentication Code

11 “{Pad:'", 6, T}" | 9 74, 6: Reserved

12 "{Pad:e«{bACHOrgDFIID}»,8,T}" |18 88, 8: Originating DFI {Bank) ID.. T=Routing A=A

13 "{FormatNum: ' {Eval:{FileBatches}+1}',7,8,'@","" ' ,Hid}"|11 88, 7: Batch Humber

14

15

16

17

18

19

28

4 3
ColRow: 1, 1 0K X Cancel |

a. ACH Service Class Code - The information for this field is entered in the ACH Definition
tab of the PrintBoss bank record. The variable name is {bACHSvcClasscode}.

b. Batch Count - Generates the total number of entries for the preceding batch. The variable
name is {BatchCount}.

c. ACH Batch Hash - This variable generates a value from the routing numbers entered for
each detail record in the batch. The value provides a check against inadvertent alteration of
data contents. The variable name is {ACHBatchHash}.

d. Batch Amount - Generates the sum of all check amounts for the preceding batch. The
variable name is {BatchAmnt}.

e. ACH Company ID - The information for this field is entered in the ACH Definition tab of
the PrintBoss bank record. The variable name is {bACHComplID3}.

f. Originating DFI ID - The information for this field is entered in the ACH Definition tab of
the PrintBoss bank record. The variable name is {bACHOrgDFIID}.

g. Batch Number - PrintBoss generates a sequential number for each batch in the file
beginning with 0000001. The variable name is {FileBatches?}.

2. SignOff — The SignOff tab contains fields for the “"9” record and applies to the entire file.

a. File Batches - Generates the total humber of batches in the file. The variable name is
{FileBatches}.

b. ACH Block Count - Generates the correct number of lines to create complete blocks of 10
lines or 940 characters. These appear as rows of 9 at the end of the file. The variable
name is {ACHBlockCount}.

c. File Count - Generates the total humber of entries in the file. The variable name is
{FileCount}.
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d. ACH File Hash - This variable generates a value from the routing numbers entered for
each detail record in the file. The value provides a check against inadvertent alteration of
data contents. The variable name is {ACHFileHash}.

e. File Amount - Generates the sum of all check amounts in the file. The variable name is
{FileAmnt}.

NOTE: Changes should not be made to the ACH file without consulting a Wellspring Software
technician as these variables are defined by NACHA.

Click OK to save changes to the Editing Form.

NOTE: Additional setup may be needed in the Form including:
e Setting up E-mail
e Assigning ACH fields in the Form instead of using the Payee List.
e Adding Process Page commands to determine when to print the ACH file when live checks
are included in the print batch from the accounting system.

Step 5: Creating the ACH File

The ACH file is created automatically during the check/EFT print process. No further steps by the
users are necessary.

ADDITIONAL INFORMATION

Please see our website for additional information.
You will find the following documents helpful:
Q1029 Capturing and Assigning Text

Q1291 ACH Overview.pdf

Q1000 PrintBoss_Manual.pdf
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Appendix

ACH Variable Definitions for use with PrintBoss

The PrintBoss bank stores the company (originator) data for the ACH file. These fields are
referenced on the SignOn, Header, and Footer tabs in the ACH File Editor and all begin with a
lower case “"b"”. For example, {bACHImdDstNo} stores the bank routing number.

File Header Record Fields
These are the field referenced in the SignOn tab of the ACH File Editor.

Immediate Destination {bACHImdDstNo}
Immediate Origin {bACHImMmdOrgNo}
Immediate Destination Name {bACHImdDstName?}
Immediate Origin Name {bACHImdOrgName}
File ID Modifier {bACHFileIDMode}
Pre-Note Override {ACHPreNote}

Company/Batch Record Fields

These are the fields referenced in the Header tab of the ACH File Editor.

Service Class Code {bACHSvcClassCode}
Company Name {bACHCompName}
Company Discretionary Data {bACHCompDisc}
Company Identification {bACHCompID}
Standard Entry Class {bACHStdEntryClsCod}
Company Entry Description {bACHCompEntry}
Originating DFI Identification {bACHOrgDFIID}

Balance Record Fields

These fields are used in Balance Record tab of the ACH File and are defined in the bank record

Balanced File

Routing Number

Bank Account Number
Account Name

Payee List Variables

{bACHBalFile}
{bACHBalRout}
{bACHBalAcct}
{bACH BalName}

Account Type/Transaction Code {ACHTransCode}
ACH PreNote {ACHPreNote}
ACH PreNote Print Check {ACHPreNotePrint}
Active {ACHActive}
Amount {ACHAmount}
Bank Payee List {BPayeelList}
Check Amount {ACHChkAmnt}
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ACH Implementation

Continued
Effective Date {ACHEfctvDate}
ACH Pre-Note {ACHPreNote}
Bank Account {ACHRecvBankAcct}
Bank ID {ACHRecvBankID}
DFI (Bank) Account Number {ACHRecvBankAcct}
Discretionary Data {ACHRecvDisc}
Receivers ID {ACHRecvID}
Receivers Name {ACHRecvName}
Status {ACHStatus}
Total {ACHTotAmnt}
Transaction Code {ACHTransCode}
Bank Payee List {BPayee List}
Payee ID {PLPayee ID}
Payee Name {PLPayeeName}
Payee Email Address {PLEmail}
Payee Email Address#2 {PLEmail2}
Payee Miscellaneous {PLMisc}
Payment Type {PLPaymentType}
Receiving DFI (Bank) ID {ACHRecvBankAcct}
Footer
The Footer tab contains fields for the “8” record(s) and apply specifically to a batch.
ACH Service Class Code {bACHSvcClasscode}
Batch Count {BatchCount}
ACH Batch Hash {ACHBatchHash?}
Batch Amount {BatchAmnt}
ACH Company ID {bACHCompID}
Originating DFI ID {bACHOrgDFIID}
Batch Number {FileBatches}
SignOff

The SignOff tab contains fields for the “9” record and applies to the entire file.

File Batches {FileBatches}
ACH Block Count {ACHBIlockCount}
File Count {FileCount}

ACH File Hash {ACHFileHash}
File Amount {FileAmnt}

For additional information please see PrintBoss Manual Appendix E: Variables by Category.
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